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ABSTRACT

The purpose of this thesis is to study and test the navigation for agricultural tractors
by using GPS to locate and using Pixhawk as a controller and commander. Using the
location obtained from the GPS to determine the location. After that, use the mission
planner program. To write the path of the tractor and sends path information to the
Pixhawk to instruct the motors to follow the path. and the servo motor to turn left and

right along the path laid down and use the LED light to instruct the path.
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sUTl 3.6 87391 Uno R3

3.3.2.4 nsiaentasiuaines
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e ilvdesdaunsaigaelunisuiunseaussnulan Waelaideniiagld RC ESC 20A Llpsann

T51A9 NN AL SULSIAUNDEMTUNSTULBLADS 3-6

5U# 3.7 RC ESC 20A
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5Ufl 3.8 DC Motor 3-6V.
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sUfl 3.9 Servo Motor MG90S
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g‘l.l‘ﬁ 3.10 Loadn Module 3traffic light
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Joumdalulim Pixhawk vinnudni laglddeunsuuulsanelngnaidniusi Telemetry V5 i1u

a

N4 Port USB vesmauiiames uagldniw C 159l 898510 1usnnnnaiw C/C++ tnaidgunnu



27

TUsunsu 919qlu IDE Tnganunsaiies Upload Tusunsasinumis RS232 Port Isiaelaesinu 814y
11 Bootloader
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firmware tHuduiiviminiitielunis Upload Tswnsu vwie Sketch 7idewdnluly flash rom
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3.3.5 JUABUNITIBUIUSHNTH
3.3.5.1 VUMBUNIITMIULUIHNTY TUVULNAULLDS

1. \Weausia Pixhawk fiulusunsuaiuax Ground Control System ¥plusunsy Juduun

AULUDS

g‘l.l‘ﬁ 3.11 (Weuse Pixhawk

2. deusewuuldanelaeld Telemetry V5
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3. GeusieTulaya Andines

Getting Params 1

Getting Param MAVFTP 1-1 : @PARAM/param.pck?

vathdefaults=1

5U# 3.13 Weusiesutaya Amnsiiees

4. vinns Calibration Anegdanuy

Calibrate Radio

Spektrum Bind
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5UT 3.14 N5 Calibration Ingdiady

5. ATIERUNIYINNUTDITBlILaENeINDS
6.

# Position Reverse Function Min Trim Max

1100 | [1500 | [1500 |
s o B 0 B
o0 I (150 [ (0 |

I - JE : EX : |
Radio Calibration 6  — T m,n 150,0,!
— | j oH o
c W g g 5ol

Flight Modes i Dmbed ”00 1500 19‘;!

, ol @l <l

Install Frmware

>> Mandatory Hardware >

Frame Type
Accel Calibration

Compass

o ~ = BwE=H®E
ADSB g —n v E— Rivid - L - I -
5UM 3.15 msvinureseiluaruelnes

7. AaAnlvuanisUsAu nuai 1 fe hold vigAn1sAIVANTewWBLNBS Al 2 Manual

Y a - o =i % 1Y) wa
AIUANMELUNILUYBASE Tnuav 3 Auto M IAIUANANTISNLLIRUUSRTULR

8.

Current Mode: Hold
Current PWM:  5: 1000

Flight Mode 1 PWMD - 1230

Flight Mode 2 PwM 1231 - 1360

Flight Mode 3 PWM 1361 - 1490

Flight Mode 4 PWM 1491 - 1620

Flight Mode 5 PWM 1621 - 1749

PIWM 1750 +

Flight Mode 6

5UT 3.16 sadnlvainn1sUady

9. YINANSIYRUMB RTK
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10. YIMNITINHULEUNI WaEIN1TONIAaALNEAY Pixhawk

ARDUPHLOT

5UT 3.18 N5 1UNULAUN

11. ARM 50 wazaaalvuslindu AUTO
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sUfl 3.19 feenlvmdiu AUTO

12. nmsveasadulaingmn Waypoint shansusuguis PID- TSERVO vhanuld
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SUT 3.21 msUfuguils PID

3.3.5.2 Yunaunsldaulusunsy 913l

1. mMsBenlrauluswnsy
° & & v 1Y) & | a °
Avuaszuvansaksagldnuiulusunsuves evigly Taednisivun

Yov99 Board 1Tu “aﬁ@M/Genuino Uno” laegnanwndy Tools > Board “aﬁ@ﬂﬂi Uno anagy

7322

sketch_dec20a | Arduino IDE 2.0.3
FileEdit Sketch " Taols " Help

oot et

¥ = Archive Sketch - Arduino Ydn
Manage Libraries.. Ctrl+ Shift] /' Arduine Uno
Serial Monitar Ctrl+ Shift+ ; Arduine Uno Min ’
g Type Serial Plotter E Arduino Duemilanove o Diecimila |
Arduing WIFi1071 / WiFININA Firmware Updater | Arduino Nano
CL(IL\W Uplosd S5L Root Certfcates S Mega or Mega 2500
dod Arduino Mega ADK
Board: *Arduino Uno® ] Boards Manager.. ~ Ctrl+Shift+8 Arduino Leonardo i
0 st BoardInfo ‘Arduino AVR Boards » Arduino Leonardo ETH
Dr-d%u‘lr.’ Programmer » ;C‘JTI;"JT‘,J g Arduina Micro
‘Uln\'bt?‘a' Burn Bostlosder ouTRUT}; Arduina Esplora

- ——— -~ Arduino Mini
Arduino Ethernet

Arduino Fio

2. NMSANVUANLIYLATNDIALFDN

a A

AMNUAVLIELAVND TN URAG D FDANTAIUUDIA AR TINUNLELAY

Comport Tuiadesraufiames PC 1 COM3/5 Adnuwndd Tools > Port > COM3/5 Tdfane RS232
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Juigeusegunsalszminmeuiiawmes PC Au veialulpsreulvsaaeslaens RS232 19

Serial Port ¥3nauiHas PC

IDE 203

tIn(PixhawkValue);

35U 3.23 MsfmuanInglaunesn

3. 113 Upload code asuasalulaspoulnsaians

File Edit

2

or Pr

s

dawvalusunsulaeadnindd Sketch > Verify/Compile fsguf 3.24

& sketch_dec20a| Arduine IDE2.0.2

Sketch| Tocls Help

Verify/Compile Cirl+R
Upload Cirl+U
Configure and Upload

Upload Using Programmer Ctrl+Shift=L
Export Compiled Binary Al Gt

Optimize for Debugging

Show Sketch Falder Alg=Ctrl+K

Include Library

Ardulfio NG or

older, Arduino Robot Motor, 12
Arduino Nano, Arduine Mega 11
or Mega 2560, Arduino 12
Industrial 101, Arduino Yun

Arduino Uno, Arduino 3
Ethemet, Linine One, Arduino 14
Mini, Arduino BT, Arduino-Ytin 15
Mini, Arduino Mega ADK, 16

Eﬂa ino

int PixhawkValue;
fint RED =|13;
fint YELLOW = 127
int GREEN =\ 11;
Fmt A = 1518;

F poid setup() {
Serial.begin(9608);
pinMode (2, INPUT);

pinMode(RED, OUTPUT);

pinkode (YELLOW, OUTPUT);
pinkode(GREEN, QUTPUT);

void loep() {
int readpwmvalue = digitalRead(2);

gﬂﬁ 3.24 nsdauyslusunsu

&1 Upload Code liifuuasalaendnundidenti Sketch > Upload wén

o ] 4 [ <@ [ A o Y v 4 1 A a 2/ s
i@ﬁﬂﬂz AUNMIUSUATUYINUESINARINATINAS Upload Code Trnuuasaluniseusens vasa

A Y o o w a o a
2% SUAUYNUmNA AT sU A Ul USLAS LU
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& sketch_dec20a | Arduine IDE 2.0.3
File Edit Sketch Tools Help

E — — —
Upload Cirl+l
aino

Configure and Upload

Uplead Using Programmer Ctrl+Shift+U t PixhaukValue;

) ) I it RED = 13;
E Export Compiled Binary Alt+Ctrl+5 t YELLOW = 12;
Cptimize for Debugging it GREEN = 11;
t A = 1518;
Show Sketch Folder Alt=Ctrl+ K

-

Include Library id setup() {
Add File... Serial.begin(960@);

—pinMode(2, INPUT);

Pro or Pro Mini, Arduino NG

or older, Arduino Robot 18 pinMode (RED, OUTPUT);

Maotor, Arduino Nano, 11 pinMode (YELLOW, OUTPUT);

Arduino Mega or Mega 12 inMode (GREEN, OUTPUT):

2560, Arduino Industrial E e B @ (GREEH, o

101, Arduino Yun, Arduino S

Uno, Arduino Ethernet, 14

Lining One, Arduino Mini 15 void loop() {

Arduing BT = J

Asdiino BTArduino Yiin 16 int readowmvalue - dieitalRead(2):

5Ufi 3.25 f1ds Upload Code

3.3.6 NISYUIUSLNSY

M3UA 3. Flow  Chart WAINSYIIUYelUsLNTe  SURINASH
lulpsAaulnsalaassuAIaIn Pixhawk N1UNISEINISNNIUSHATY DUdulnauiues naaa1nty
lulasasulnsaeesazdimlanlseununalaonsiadeudygiaiiduwnaind Pixhawk w1ty
' P2 v & a '
ruaulumaniinsely

Woulvvaslusinsy

. ANANUDY Pixhawk  HAN1INAIMS0LYINAU 1550 CATRIN

{ i [

lulasAaulnsaLeasdiliviaon waadh aleIRnaNe anluldvasn woadn s

[y

> RGRERN Pixhawk  Sateeninvsewinnu 1450 98y

[y

lulasmaulnsaaasdiliiann waadh Awssinaldng anlultvesn woadd su

) fA1Y84 Pixhawk HlA10g5enieA1InNImIamInY 1450 viseilrdesy

A a LY

N1 1540 gy lvlulaseeulnsataasdsliviasn Loads anandnnaing onlulvvasn woads su



fuAna1n Pixhuwk

HAUATAIATNN9TsIN

su Mission Planner

Pixhuwk >=1550

waan LED
fudenfaaing
a1l l2viaan LED 6y

ANy assnali
a

Pixhuwk <= 1450

y

waan LED
duavfinaiie
d7'lulzdviaan LED au

(PixhawkValue >= 1450) &&
(PixhawkValue <= 1540)

3.3.6.1 Source code

sU#i 3.26 Flow Chart weslUsunsy

waam LED
FuAavdiagite
d11ulmaan LED éu

fuganisineu

int PixnawkValue;

int RED = 13;

int YELLOW = 12;

int GREEN =

11;
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int A = 1510;

void setup() {
Serial.begin(9600);
pinMode(2, INPUT);
pinMode(RED, OUTPUT);
pinMode(YELLOW, OUTPUT);
pinMode(GREEN; OUTPUT);
}
void-loop() {
int-readpwmvalue = digitalRead(2);
PixhawkValue = pulseln(2, HIGH),
Serial.print("readpwmvalue :"); Serial.println(PixhawkValue);
delay(1000);
if (PixhawkValue >= 1550)
digitalWrite(GREEN, HIGH);
telsef
digital Write(GREEN, LOW);
}
if (PixhawkValue <= 1450)
digitalWrite(RED, HIGH);
Jelsef
digitalWrite(RED, LOW);
3
if ((PixhawkValue >= 1450) && (PixhawkValue <= 1540))
digitalWrite(YELLOW, HIGH);
Jelse{
digitalWrite(YELLOW, LOW);
}
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Google Earth

JUN 4.1 dunmesnduuliideuss RTK
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Mission Planner 1379 build 1.3.8375.24878

Quck  Actors Messages PrePight Gauges Drone D Tl

Turn Radius (m) Dist Traveled (m)

0.00 0.00

Dist to WP (m) GroundSpeed (m/s)
0.00 0.00
)
Vertical Speed (mys) DistToMAV

0.00 0.00

GRECINY

Turning light | Arduino IDE 2.0.3
File Edit Sketch Tools Help

Turning light.ino

pPixhawkvalue;

(RED, OUTPUT);
(YELLOW, OUTPUT);
(GREEN, OUTPUT);

(01
readpwmvalue
Pixhawkvalue = pulseIn(
d. 1000) ;
if (Pixhawkvalue >= 1550){
d drite(GREEN, HIGH);

1.println(Pixhawkvalue);

Ln 12, Col 26 UTF-8 X No board selected £}

A9 n-2 JUBuesivlUsunTY 91359 IDE



Source Code

int PixhawkValue;
int RED = 13;

int YELLOW = 12,
int GREEN = 11,
int A = 1510;

void setup() {
Serial.begin(9600);
pinMode(2, INPUT);
pinMode(RED, OUTPUT);
pinMode(YELLOW, OUTPUT);
pinModé(GREEN; OUTPUT);

}
void loop() {
int readpwmvalue = digitalRead(2);
PixhawkValue = pulseln(2, HIGH);
Serial.print("readpwmvalue :"); Serial.println(PixhawkValue);
delay(1000);
if (PixhawkValue >="1550){
digitalWrite(GREEN, HIGH);
Jelsef

digitalWrite(GREEN, LOW);
}
if (PixhawkValue <= 1450)

digitalWrite(RED, HIGH);
telse{

digitalWrite(RED, LOW);



}
if ((PixhawkValue >= 1450) && (PixhawkValue <= 1540))
digitalWrite(YELLOW, HIGH);
Jelse{
digitalWrite(YELLOW, LOW);
}
}
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FLY SKY
5. 2.4GHz System <, 2.4GR#

AUTOMATIC FREQUENCY 2 A

HOPPING DIGITAL SYSTEM

AFHDS2A stands for "Automatic Frequency Hopping
Digital System 2A". This highly sophisticated radio
transmission system will guarantee you a long range,
jamming free and long battery life experience. This is
the result of years of research and testing and makes
Fly Sky one of the world leader in the market.

AFHDS2AR = RISBIRE MM RENH
5. BRI BEETNERESARRS  XIR
AR LR IFAOIET  FIRASHI85 T HRRR(E,
TR RIGIERHIES L — —— SRR
RERATDFEIURS FROAR,

RF specifications:

RF range: 2.405-2.475GHz

Channel bandwidth: 500KHz

Number of channels: 142

RF power: less than 20dBm

RF mode: AFHDS 2A(Automatic Frequency Hopping
Digital System 2A)

Modulation type: GFSK

Antenna length: 26mm*2(dual antenna)

RX sensitivity: -105dBm

SR 33
SEEE : 2.405-2.475GHz

RERZSRE | S500KHz

RERNE : 1429

REIIHE | F/TF20dBm

REHR : AFHDS2A(B ZRILBRARIHIABFREK)
&IBHI ¢ GFSK

REIKE : 26862 (WKL)

FEWHREUEE © -105dBm

/N\Danger:

Misuse of this radio system can lead to serious
injuries or death. Please read completely this
manual and only operate your radio system
according to it.

i

HREAERPRESSYWENHERZRT.
BEEBH=EMEXARBFNR , FEEEBY
T R PSR AR I TF A B0 BB MR (F.

The 2.4GHz radio band has a completely different
behavior than previously used lower frequency bands.
Keep always your model in sight as a large object can
block the RF signal and lead to loss of control and
danger. The 2.4GHz RF signal propagates in straight
lines and cannot get around objects on its path. Never
grip the transmitter antenna when operating a medel
as itdegrades significantly the RF signal quality and
strength and may cause loss of control and danger

2 AR AR R AT TS E
SRTLRIRER. (RN BRI SRRER YT
BRONEEEN | EAKNMWDE LIEGFLR
AFESATSBERABACR. 246KEB4
RESLOEASEN , SRS BSYIHITE
W, EEATES, PREARESNXE  EUE
SAXHBEEREBESHERNEE , SXE
BREXBRRR,

ADanger:

Always turn on the transmitter first then the receiver.
When turning off the system, always turn off the
receiver first then the transmitter. This is to avoid
having the receiver onitself as it may pick a wrong
signal and lead to erratic servo movements. This is
particularly important for electric powered models
as it may unexpectedly turnon the motorand lead
to injuries or death.

gy

BREFRR, MRS TR, AEBARK
B, {FLEEAN BARSCHFEKANEIR &
EBEXRARIIN. XERFT LB RN 2 )
HRESTSRNORARBLAENE R, RTTFHE
RBRRANEE , BHCHTRSHDIARR
EMBEEARGT.
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This radio system uses low power electronic components and a very sensitive receiver chip. The RF

modulation uses intermittent signal transmission thus reducing even more power consumption. Comparatively,
this radio system uses only a tenth of the power of a standard FM system.

W ARGEBENRBF THNBSRUERMIGF, TEBMERRRBEMEESERE , BlAKRE

BT RPHE, WRMS , WRENFHNFMEAN+HZ—.

2 3

6.System Characteristic ERISE

AFHDS2A system has the automatic identification function, which can switch automatically current mode between
single-way communication mode and two-way communication mode according to customer needs. The two-way
communication mode with data return function can help users understand current working status better and make
the fight more enjoyable.

AFHDS2ARGRAEHE—NE EaNRBIIE , RIBBFEREMIRR-WEESERK. ENEDEMRIT |
E&ERESETE  SEFNFERRNSHITERS | BNRERERESE,

AFHDS2A has built-in multiple channel coding and error-correction, which improve the stability of the
communication, reduce the error ratio and extend the reliable transmission distance.

AFHDS2AR#N BESEEEROBMUIGHZ | FRNESTBEREE  WNEERIGE , BNTRE
Lihick o

This radio system works in the frequency range of 2.405 to 2.475GHz. This band has been divided into

142 independent channels. Each radio system uses 16 different channels and 160 different types of hopping
algorithm. By using various switch-on times, hopping scheme and channel frequencies, the system can

) an Om guarqnlea a jamming free radio transmission.
; IR G TIP3 EIR2.40582.475GHz, BNRBRESH142V RN, BERBRGEM6D
REERAF1 60 A BNSME R, BIFNHERE  BANALEREAREDOMAR | BERELEER

FIERES.

This radio system uses a high gain and high quality multi directional antenna. It covers the whole frequency

band. Associated with a high sensitivity receiver, this radio system guarantees a jamming free long range radio
transmission.

HRGROSEROE AL , BERCRAEE, RBABIRERKY , RGBS ARG TIENE
BESTFIH.

Each transmitter has a unique 1D. When binding with a receiver, the receiver saves that unique ID and can

accepts only data from that unique transmitter. This avoids picking another transmitter signal and dramatically
increases interference immunity and safety.

BERFNE—NE—HIDF | MAHLKNIEZE  BEHUREX N IE—i91DIH B R Z X MDD

RENEHNES., XNTLIBZRERBINEENGES  AKSBRTHEAIZSHE.

Digital pragotingl iadio Gotrol System |



SPECIFICATIONS :

NS

Number of channels: 6

Model type: fixed-wing/glider/ helicopter
RF receiver sensitivity: -105dBm);
Modulation: GFSK

System type: AFHDS2A/AFHDS
Channel resolution: 1024 steps
Bind port: yes

Power port: yes(VCC)

Power: 4.0-6.5VDC

Weight: 6.4g

Antenna length: 26mm

Size: 40.4*21.1*7.35mm

Color: black

Certification: CE, FCC.

Http:
®

//www. flysky-cn. com

1BiEMN : 6NBIE

2. EANR . ERR/EBI/ETN

3. EWRWE : -105dBm

4. B%)5: GFSK

5. R BTRIRERE IR
HFREEF—KRR)

6. BiESEIR: 10244

7. 90B%EO: B

8. BBiREL: B(VCQ)

9. BBiftRfE: 4.0-6,5V DC

10. Y E/&: 6.4%

11. REEIKAE: 268K

12. 5MERT: 40.4*21.1%7.358 ¥

13.5MREE: B

14. KHUAIE CE. FCC,

FLY SKY

7. Transmitter specifications. ¢

Transmitter specifications:

Number of channels: 6

Model type: fixed-wing/glider/ helicopter
Channel resolution: 1024 steps

Power supply: 6V (1.5VAAXx4)

(32 A0S 2 1y
MODELS : FS$-i6

Low voltage warning: Icon blinks and alarmlessthan4.2V
Icon blinks and short alarm less than4.0V

No-operation warning: The transmitter will alarm if
there is no operation more
than one minute.

Antenna length: 26mm*2 ( dual antenna)

Color: Black

Size: 174*89*190mm

Weight: 392g

Certification: CE, FCC

MNESH

1LIBE¥ : 6
EEHP . EEE/EBI/ER

3. BuE o g 10245

4. B NEBJE: 6V (1.5VAAX 4)

5. (£ EIRENES: EF42ABRINGHEKIRE
{EFA.0ABIRINGFHERIRE

6. XHIREINEE: FH I TRIF1D S %ISR e

7. REIKE: 265K 20K )

8. HpMEE: BE

9. MRS 174*89*190F K

10 By ER: 392

11. ZHUAIE CE. FCC

8. Receiver specifications =

e Aes 2R
MODELFS-iAG

‘V‘\‘;

Emou’

EINSE
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9. RX setup introductiaon AR EB s _iﬁ

Dual antenna notes

below:

1.The two antennas must be kept as straight as possible.Otherwise,control range will be reduced.

2.The two antennas should be placed at a 90 degree angle to each other,as illustrated in the three pictures
below.

3.The antennas must be kept away from conductive materials,such as metal and carbon.A distance of at
least 1.5cm is req uired for safeop eration.Conductive materials will not affect the coaxialp art of the
antenna,butitis important that the coaxials are not bent to a severe radius.

4 Keep antennas away from the motor,speed controller and other noise souces as much as possible.

" Digitafpropationaladiocomtigisystm

AT IR REBEEE R  EERLAT/UR

1. REFENKESE  BUISERE)EHEm

2. WRLEHIRMBHIRSEIC WEA=FHSN) XAFESRNESHE , FENERIHRSCREEETE |
3. RERZRARGrESmSHE | ZORE| SomAGRIEE, MEBSERASZHIRY , BRI ESH ;
4. REJgeiRISREOnmEEahil. e  MEEHNRER,

‘ In order to make sure maximum distance between the transmitter and receiver please follow the directions

2

Receiver

UL

Receiver
(E113)

4
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FLY SKY
CHURE IR S (R 28 E IR
ety O
To Bat'tery E'f {eHe}
1 ‘F.; CH5
a2 ( ) - )
FX O A
i Switch R (cha)
Charging Harness arie) CH1
Jack 5 o (CHe)
I 5 (CH3) (CH2) (CH2)
= (CHa) {CH4)
(CH2) o R e
UG
{ SERAEHICHY FCHS )
(CH1)

Receiver
&

WA,
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Rudder (CH4) n&e
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Optional '
b Switch | ? Gyro |
Harness e System
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Receiver

T
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10. O01. Receiver and servo connections (aircraft]

10. 02 Receiver and servo connections(helicopter) g

bt AT = \ i
BAIRERIE ISR
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®

FLY SKY

11. 03 Shut down E2)

1. Disconnect the receiver battery 1, MRFF AT ER IR
2. Switch off the transmitter 2. XARSH

Shut down
vl

Rx power off

12. Definition of key functions <, @m@ay
Antenna = X&

Handle # i#5F

FFXB+ Switch B (SwB)

= e N

Ry

— ol O = ® )
FF5A  Switch A (SwA)—/# ,’//L\“ P wl | Switch C (SWC )« FF4C
IS FL1skY J Switch D (SwDY- FF%D
. e~ -, 3
P25 + HOOK I ZZ7 TN\ e
/ ¢ —— \Y s

Right stick = 74\#F
F2UMT * Left stick

FE&W “Lefttrims “,‘/“, - ,;} “
ik | / /

(%8 * Up (Key) —§ N =i o OK key « KEaAE
T(&EE) * Down (Key) . Cancel key + SSIREGEH
LCDSE=E+ LCD display

Power switch + FBjRF X
XIFE(FLE) * Binding(Key)



Specifications

Processor

Sensors

Power

Interfaces

Dimensions

Pixhawk 2.4.8

32-bit ARM Cortex M4 core with FPU
168 Mhz/256 KB RAM/2 MB Flash

32-bit failsafe co-processor

MPU6000 as main accel and gyro
ST Micro 16-bit gyroscope
ST Micro 14-bit accelerometer/compass (magnetometer)

MEAS barometer

|deal diode controller with automatic failover
Servo rail high-power (7 V) and high-current ready

All peripheral outputs over-current protected, all inputs ESD

protected

5x UART serial ports, 1 high-power capable, 2 with HW flow

control

Spektrum DSM/DSM2/DSM-X Satellite input
Futaba S.BUS input (output not yet implemented)
PPM sum signal

RSSI (PWM or voltage) input

12C, SPI, 2x CAN, USB

3.3V and 6.6V ADC inputs

Weight 38 ¢ (1.3 02)



® Width 50 mm (2.0”)

® Height 15.5 mm (.6”)

® [ength 81.5 mm (3.2”)
Purchase

The Pixhawk 1 was originally manufactured and sold by 3DR.

A slightly improved but fully compatible variant can now be obtained from mRo: mRo

Pixhawk 2.4.6 Essential Kit!

Pixhawk connector assignments{

AN (controller

C splitter of co

3. Analog
Analog
£

ussport

1 Flight management unit (FMU) power

FMU bootloader mode (flashing) ar error (solid)

IS

Input/output unit power

H W

1/0 bootloader mode (flashing) or error (solid)

Activity (flashing indicates all units responsive)

Pixhawk top connectors


https://store.mrobotics.io/Genuine-PixHawk-Flight-Controller-p/mro-pixhawk1-minkit-mr.htm
https://store.mrobotics.io/Genuine-PixHawk-Flight-Controller-p/mro-pixhawk1-minkit-mr.htm
https://ardupilot.org/copter/docs/common-pixhawk-overview.html#pixhawk-connector-assignments
https://ardupilot.org/copter/_images/Pixhawk_with_legend.jpg
https://ardupilot.org/copter/_images/pixhawk-status-LEDs-definition.jpg

Spectrum Satellite Receiver.
Motor Safety Switch
Telemetry Radio

Front

MultiColor LED 12C Serial & External Magnetometer

6.6 volt Analog Input

Pixhawk PWM connectors for servos and ESCs and PPM-SUM in and SBUS out

SBUS OUT

Main PWM OUT

AUX PWM OUT

Pixhawk connector diagram9q


https://ardupilot.org/copter/docs/common-pixhawk-overview.html#pixhawk-connector-diagram
https://ardupilot.org/copter/_images/PixhawkLabled.jpg
https://ardupilot.org/copter/_images/pixhawkPWM.jpg

AIRSPEED
POWER
12C (external compass, LED)

RGB LED
AMALOGxZ

CANBUS

SER3 (GPS)

JTAG
SER4 (NSH Shell)

SER1

RESET FMUI

RESET 10 sER2

ARM SWITCH/LED
SPEKTRUM/DSM

BUZZER
oo 6H DA QG

I depehep cp e efie

) ))‘)”“‘LS'.!'.!'.Sﬁ

- 6 PWM-FM_-1
SBUS-out PWM-10-8 PWM-IO-1
RESI-in

For all connectors pin 1 is on the right in the above image

Serial 1 (Telem 1) and Serial 2 (Telem 2) Pins: 6 = GND, 5 = RTS, 4 = CTS, 3 = RX, 2 = TX,
1 =5V.

Pixhawk connector pin assignments

TELEM1, TELEM2 ports

Pin Signal Volt
1 (red) vCC +5V
2 (blk) TX (OUT) +3.3V
3 (blk) RX (IN) +3.3V
4 (blk) cTs +3.3V
5 (blk) RTS +3.3V
6 (blk) GND GND



https://ardupilot.org/copter/_images/PixHawk_labelled.png

£
=p

L2d port

Pin Signal Volt
1 (red) vCC +5V
2 (blk) TX (OUT) +3.3V
3 (blk) RX (IN) +3.3V
4 (blk) CAN2 TX +3.3V
5 (blk) CAN2 RX +3.3V
6 (blk) GND GND

SERIAL 4/5 port - due to space constraints two ports are on one connector.

Pin Signal Volt
1 (red) VCC +5V
2 (blk) TX (#4) +3.3V
3 (blk) RX (#4) +3.3V
4 (blk) TX (#5) +3.3V
5 (blk) RX (#5) +3.3V
6 (blk) GND GND




ADC 6.6V

Pin Signal Volt
1 (red) VCC +5V
2 (blk) ADC IN up to +6.6V
3 (blk) GND GND
ADC 3.3Vq
Pin Signal Volt
1 (red) VCC +5V
2 (blk) ADC IN up to +3.3V
3 (blk) GND GND
4. (blk) ADC IN up to +3.3V
5 (blk) GND GND
12Cq
Pin Signal Volt
1 (red) vCC +5V
2 (blk) SCL +3.3 (pullups)



https://ardupilot.org/copter/docs/common-pixhawk-overview.html#adc-3-3v
https://ardupilot.org/copter/docs/common-pixhawk-overview.html#i2c

3 (blk) SDA +3.3 (pullups)
4 (blk) GND GND
CANg
Pin Signal Volt
1 (red) vce +5V
2 (blk) CAN H +12V
3 (blk) CAN L +12V
4 (blk) GND GND
SPIY
Pin Signal Volt
1 (red) VCC +5V
2 (blk) SPI_SCK 3.3V
3 (blk) SPI_MISO +3.3V
4 (blk) SPI_MOSI +3.3V
5 (blk) ISPI_NSS +3.3V
6 (blk) IGPIO +3.3V



https://ardupilot.org/copter/docs/common-pixhawk-overview.html#can
https://ardupilot.org/copter/docs/common-pixhawk-overview.html#spi

7 (blk) GND GND

POWERq
Pin Signal Volt
1 (red) vCC +5V
2 (blk) VCC +5V
3 (blk) CURRENT up to +3.3V
4 (blk) VOLTAGE up to +3.3V
5 (blk) GND GND
6 (blk) GND GND
SWITCHY
Pin Signal Volt
1 (red) VCC +3.3V
2 (blk) I0_LLOADA_SAFETY GND
3 (blk) SAFETY GND

Console Portq

The system’s serial console runs on the port labeltoadf SERIAL4/5. The pinout is

standard serial pinout, to connect to a standard FTDI cable (3.3V, but it’s 5V tolerant).


https://ardupilot.org/copter/docs/common-pixhawk-overview.html#power
https://ardupilot.org/copter/docs/common-pixhawk-overview.html#switch
https://ardupilot.org/copter/docs/common-pixhawk-overview.html#console-port

Pixhawk FTDI

1 +5V (red) N/C
2 Tx N/C
3 Rx N/C
4 Tx 5 Rx (yellow)
5 Rx 4 Tx (orange)
6 GND 1 GND (black)

915l UNO R3

(©.0] Arduino® UNO R3

Product Reference Manual
SKU: AD00066

Description

The Arduino UNO R3 is the perfect board to get familiar with electronics and coding. This versatile microcontroller
is equipped with the well-known ATmega328P and the ATMega 16U2 Processor.
This board will give you a great first experience within the world of Arduino.

Target areas:

Maker, introduction, industries



Features
= ATMega328P Processor
= Memory

= AVR CPU at up to 16 MHz
= 32KE Flash

= 2KB SRAM

= 1KBE EEFROM

n Security

m Power On Reset (POR)
= Brown Out Detection (BOD)

= Peripherals

2x B-bit Timer/Counter with a dedicated period register and compare channels

1x 16-bit Timer/Counter with a dedicated period register, input capture and compare channels
1x USART with fractional baud rate generator and start-of frame detection

1= controllerfperipheral Serial Peripheral Interface (SP1)

1x Dual mode controller/peripheral [2C

1x Analog Comparator {AC) with a scalable reference input

Watchdog Timer with separate on-chip oscil lator

Siz PWM channels.

Interrupt and wake-up on pin change

= ATMegal16U2 Processor
= §-hit AVRE RISC-based microcantraller

= Memory

m 16 KB |5P Flash

= 5128 EEPROM

n 512B SRAM

» debugWIRE interface for on-chip debugging and programming
n Power

m 27-55vols
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T IVAAN].. 272 e PN 0 TS

1 MNC MC Not connected

2 IGREF IOREF Reference for digital logic V - connected to 5V
3 Resst Reset Resat

4 +3M3 Power +3W3 Power Rail

5 +54 Power +5W Power Rail

& GMD Pawer Ground

7 GND Pawver Ground

a VIN Power Vialtage Input

9 AD Analog/GPIO Analog input 0/GPIO

10 Al Analog/GPIO Analog input 1 /GPIO

" A2 Analog/GPIO Analog input 2 /GFIO

12 A3 Analog/GPIO Analog input 3 /GPIO

13 A4rSDA Analog inputf2C Analog input 4/12C Data line

14 ALMSCL Analog input/12C Analog input 512C Clock line
5.2 JDIGITAL

Pin . [Function— ] Description | | RV 7 A8
1 [1y] Digital/GPIO Digital pin WGPIO

2 o Digital/GPIO Diigital pin 1/GPIO

3 D2 Digital/GPIO Digital pin 2/GPIO

4 [1E] Digital/GP10 Digital pin 3/GPIO

5 D4 Digital/iGPID Digital pin 4/GPIO

6 D5 Digital/GPIO Digital pin 5/GPIO

7 D& Digital/GPIO Digital pin 6/GPIC

a8 o7 Digital/GPIO Digital pin 7/GPIC

9 D& Digital/GPIO Digital pin 8/GPIO

10 D9 Digital/GPIO Digital pin %/GPIO

" 55 Digital 5PI Chip Select

12 MOsI Digital SP11 Main Out Secondary In

13 MISO Digital SP1 Main In Secondary Out

14 SCK Digital 5Pl serial clock output

15 GHND Power Ground

16 AREF Digjtal Analog reference voltage

17 AdrsDd Digital Analog input 4712C Data line (duplicated)
18 ASSDS Digital Analog input 5/12C Clock line (duplicated)






